
Product Guide 



Page i 

Table of Contents 

Introduction ..................................................................................................................................... 1 

PowerPoint 2011: At-a-Glance ...................................................................................................... 2 

Get easier access to the right tools, at the right time ............................................................................................... 2 
Make the media fit the message ..................................................................................................................................... 2 
Create extraordinary presentations ................................................................................................................................ 3 
Save time and simplify your work .................................................................................................................................... 3 

Work more easily with others ........................................................................................................................................... 3 
Work how, when and where you choose .................................................................................................................... 4 

PowerPoint 2011: A Closer Look .................................................................................................. 5 

Ribbon New! ........................................................................................................................................................................... 6 
PowerPoint Presentation Gallery New! .......................................................................................................................... 8 
Media Browser New and Improved! ............................................................................................................................ 10 

Embed and Format Movies New! ................................................................................................................................. 12 
Movie and Audio Controls New and Improved! ..................................................................................................... 14 
Picture Editing Tools New and Improved! ................................................................................................................. 15 
Compress Pictures New! .................................................................................................................................................. 17 

Slide Transitions Improved! ............................................................................................................................................. 18 
Animations Improved! ....................................................................................................................................................... 20 
Additional Office Themes Improved! ........................................................................................................................... 21 
Additional SmartArt Graphics Improved! ................................................................................................................... 23 

Tables and table styles Improved! ................................................................................................................................. 25 
Charts Improved! ................................................................................................................................................................ 26 
Presenter View Improved! ............................................................................................................................................... 27 
Dynamic Reordering New! .............................................................................................................................................. 29 

Presentation Sections New! ............................................................................................................................................. 31 
Find tools Improved! .......................................................................................................................................................... 32 
Streamlined Performance Improved! ........................................................................................................................... 33 
Visual Basic for Applications (VBA) Improved! .......................................................................................................... 34 

Help Improved! .................................................................................................................................................................... 35 
Zoom Improved! ................................................................................................................................................................. 36 
Design and Presentation Advice New! ........................................................................................................................ 37 
Broadcast Slide Show New! ............................................................................................................................................. 39 

Co-Authoring New! ........................................................................................................................................................... 40 



Page ii 

Rich Presence and On-the-Spot Communication New! ....................................................................................... 42 
Information Rights Management (IRM) New! ........................................................................................................... 43 
Compare and Merge Improved! ................................................................................................................................... 44 
PowerPoint Web App New! ............................................................................................................................................ 46 
Save to SkyDrive New! ...................................................................................................................................................... 48 

Save to SharePoint New! .................................................................................................................................................. 49 

Insider Tips & Tricks ...................................................................................................................... 50 

Where to Find It ............................................................................................................................ 58 

Version Comparison ..................................................................................................................... 64 

FAQ ................................................................................................................................................. 71 

Requirements\Disclosures ............................................................................................................ 79 

Colophon ....................................................................................................................................... 81 
 



Introduction  
Would you like to create presentations quickly, easily, and with more engaging results? Do you want to 
share more dynamic presentations? Are you bored of bullets, grasping for great graphics, and looking 
for new ways to make your ideas stand out? 

From faster, easier ways to accomplish everyday tasks, to new technologies that simplify working with 

others across platforms and help you take your results to a new level, Microsoft® PowerPoint® for Mac 
2011 (PowerPoint 2011) delivers the tools you need. 

§ Familiar. Get things done more quickly and easily, with familiar tools that enable you to get started 
right away and create the engaging, professional-quality presentations you want. 

§ Compatible. Share content seamlessly with others on both Mac and Microsoft Windows 

computers.  You can even edit the same presentation at the same time.1 

§ Professional. Access your documents when and where it’s convenient for you — online and on 

the road — rather than being tied to your computer.1 

Welcome to PowerPoint 2011 — our most intuitive, compatible, and powerful release yet. 

1 Requires Microsoft SharePoint® Foundation 2010 for enterprise or, for personal and small business use, 
a free Windows Live® ID to save and access files via Windows Live SkyDrive®. 
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PowerPoint 2011 At-a-Glance 

Create incredible content 
Whether you need a few slides to share with friends, colleagues, or classmates, or an award-winning 
presentation, you want your ideas to jump off the screen.  Fortunately, PowerPoint 2011 delivers the 
features you need to create great-looking, dynamic presentations that help you captivate your 
audience and express yourself effectively. 

Take a glance at just some of the new and improved tools in PowerPoint 2011, designed to help you 
create brilliant, professional presentations more easily than ever before. 

Get easier access to the right tools, at the right time 

Great features can help you be more productive, but only if you can find them when you need them. 
Fortunately, PowerPoint 2011 gives you familiar, intuitive tools that enable you to work the way you 
want.  

§ The new ribbon in PowerPoint 2011 puts the commands you need at your fingertips so you can 
focus on the end product, not how to get there. Get exactly the tools you need, when you need 
them. 

§ The new and improved Media Browser gives you centralized access to all of the media you need 

in your presentations. Just drag to insert content from your iPhoto albums, iTunes playlists, and 
iMovie libraries as well as shapes, Clip Art, and more. 

§ The new PowerPoint Presentation Gallery gives you easy, organized access to a wide range of 

professionally designed and online templates and themes, your own custom templates and 
themes, and your recently opened documents. Start customizing built-in designs with just a couple 
of clicks and preview your results even before you create the presentation.  

Make the media fit the message 

New and improved, easy-to-use tools give you the power to customize the media in your 
presentations for professional-quality results every time. 

§ Use new and improved picture editing features — including a new background removal tool as 
well as advanced correction, color and cropping features — to quickly fine-tune the pictures in 

your documents without the need for additional photo-editing programs. 
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§ Embed and format movies from within PowerPoint. The embedded movies become part of 

your PowerPoint presentation, so you don’t have to manage additional files when sharing with 
others. 

Create extraordinary presentations 

Design, layout, graphics, and effects all work together to help you communicate your ideas. Not a 
professional designer? No problem — you’re just a few clicks away from slides that help maximize the 
impact of your message. 

§ Add dynamic 3-D slide transitions and an improved, expanded selection of animation effects 
that captivate your audience and focus their attention on what you want them to see.  

§ Take advantage of more professionally designed, customizable Office themes, improved chart 
tools, and a wide selection of additional SmartArt® graphics — including many new layouts for 
organization charts and picture diagrams. 

Save time and simplify your work 

No matter what type of presentation you create, you want to focus on your content and audience, not 
the tasks associated with creating and presenting your slides. PowerPoint 2011 delivers new and 
improved tools that simplify and save you time at every step. 

§ Simplify complex builds and layouts with new dynamic reordering. Get an instant, 3-D view of all 
layers on your slide and simply drag to reorder objects. 

§ Organize, access and assign slides with ease using new presentation sections. 

§ Make it look effortless with the improved Presenter View. A consolidated view of timing, notes, 

and what’s coming next keeps you in control of your presentation so that you can focus on your 
audience and the important ideas you’re there to share. 

Work more easily with others 
You may share presentations with colleagues, classmates or friends, or maybe you need to work with 
others on a team project. Regardless, the complications and delays that can arise when sharing or 
working together on content can be frustrating to say the least. That is, until now. PowerPoint 2011 
makes waiting your turn a thing of the past and gives you new and improved tools that make sharing 
your work simple and hassle-free – across platforms or across continents. 
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§ Broadcast your slide show live to people in other locations, whether or not they have 
PowerPoint installed.2 

§ You can now edit the same presentation, at the same time, as other people in other 

locations.3 You can even communicate instantly as you work, directly from PowerPoint.4 

Work how, when, and where you choose 
Ideas, deadlines, and work emergencies don’t always occur conveniently when you are at your desk. 
Fortunately, PowerPoint 2011 gives you the power to get things done when and where you want. 

It’s easy to take your PowerPoint 2011 presentations with you and stay on top of your work when 
you’re on the go. 

§ Microsoft PowerPoint Web App enables you to view a high fidelity version of your 
presentations, make light edits, or view your presentation slide show. Access some of the same 

formatting and editing tools that are in PowerPoint 2011, and work in a familiar editing 
environment, from almost any computer with a web browser.5 

§ Keep your presentations accessible when and where you need them by saving them to a 

Windows Live® SkyDrive® folder or a Microsoft SharePoint® 2010 site directly from within 
PowerPoint. (For an introduction to SkyDrive or SharePoint, check out windowslive.com/skydrive 
or sharepoint.com.) 

 
2 Requires a free Windows Live ID. Broadcasting via Windows Live is a free service that enables up to 50 attendees per broadcast.   

3 Requires SharePoint Foundation 2010 for enterprise use or, for personal and small business use, a free Windows Live ID to save and access files 
via SkyDrive. 

4 Initiating an instant message (IM), voice or video conversation from within PowerPoint 2011 requires either Microsoft Messenger for Mac 8 or 
Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac 2011. Your computer must have an installed 
microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator for Mac. 

5 Office Web Apps require an appropriate device, Internet connection, supported Safari, Firefox, or Internet Explorer browser, and either 
SharePoint Foundation 2010 for enterprise or, for personal and small business use, a free Windows Live ID to save and access files via SkyDrive. 
There are some differences between the features of Office Web Apps and the Office 2011 applications. 

http://windowslive.com/skydrive
http://sharepoint.com


 

Create incredible content 
New and improved tools give you the power to 
easily create professional-quality content. An 
updated, familiar environment helps you get 
started right away. And seamless cross-platform 
compatibility enables you to work with 
confidence, knowing that the presentations you 
create will look great when you share them with 
others who work on Mac or on Windows. 

PowerPoint 2011: A Closer Look 
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Ribbon 
N

ew
! 

Get the commands you need when and where you want them. The new ribbon, available across the 
Microsoft Office for Mac 2011 applications, gives you easy access to more commands so you can focus 
on the end product rather than how to get there.  

The ribbon brings together features formerly spread across several locations, such as the Elements 
Gallery and Formatting Palette, to give you a streamlined and more flexible work experience. It’s 
designed to help you access and use the full range of features that PowerPoint provides — so that you 
can get more done in less time. For example, theme options are now at your fingertips on the Themes 
tab. Get themes and theme formatting options all in one place that were previously split between the 
Formatting Palette and the Elements Gallery.  

§ The standard tabs that you see on the ribbon are organized to display commands relevant to a 
given task, so that you can get to what you need more quickly.  

§ The ribbon also provides contextual tabs to give you exactly the tools you need, when you need 

them. For example, when you select a picture, the Format Picture tab appears on the ribbon, as 
shown in Figure 1, with a broad range of picture formatting and editing tools. 

Figure 1: Contextual tools ,  such as the Format Picture tab shown here, automatical ly become 
avai lable when you need them. 
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 Quick Tips:  

§ You can easily configure the ribbon to display only specific tabs or to rearrange the order in 
which tabs appear. On the right edge of the ribbon, click the gear icon  to access Ribbon 
Preferences or Customize Ribbon Tab Order. 

§ Click the active tab name (such as Home or Themes) to minimize or expand the ribbon. Or, click 
the carat icon  on the right edge of the ribbon, to minimize or expand the ribbon. 

§ The purpose of the 
ribbon is to give you 
fast, familiar, and 
easier access to more 
features – not to make you 
change the way you work. With that 
in mind, Office 2011 still provides the 
menus and core toolbars that you 
might know from earlier versions.  
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PowerPoint Presentation Gallery 
N

ew
! 

The new PowerPoint Presentation Gallery makes it a snap to access all of the themes, templates, and 
presentations you need and to customize themes and templates in virtually no time. You get access to 
a wide range of professionally designed themes and built-in templates along with multi-page previews 
and new instant customization tools. Additionally, from this one central location you can access a wide 
range of templates hosted online as well as your own custom templates and your recently opened 
documents. 

§ Move your mouse pointer from left to right over previews of built-in themes for examples of slides 
created using that theme. Move your mouse pointer in the same direction over a built-in template 
preview to see all slides in that template. 

§ Even before you create your presentations, use the new customization pane to change the fonts, 
colors, and even the aspect ratio for the selected built-in template or theme. Preview your changes 

across all pages of the template or across several sample layouts for the active theme.  

§ Access the full range of PowerPoint templates and themes that are hosted online by Microsoft 

(both professionally-designed and community-submitted content). Browse online content by 
category, search by keyword, and then create your presentation with just a couple of clicks — no 
cumbersome downloads, browsers, or third-party tools required. 

§ Access your recent presentations by date, along with an indicator of how many presentations are 
available for each date range. 
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Figure 2: Get mult i-page previews, instant customizat ion, and onl ine template access in the new 
PowerPoint Presentat ion Gal lery.  

Quick Tips:  

§ Keyboard users can press Command+Shift+P to access the PowerPoint Presentation Gallery. In 
the gallery, customize your view with buttons to show or hide recent presentations and the 
customization panel  , as shown in Figure 2. 

§ If you use the color and font schemes in the PowerPoint Presentation Gallery to customize a 
template and do not see changes, the template design may not have been created using 
theme-aware colors and fonts. For example, a template might be created to intentionally retain 
specific colors that are relevant to its content — or the design may be created with images 
rather than objects that use PowerPoint fills.  
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Media Browser 
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The new Media Browser, available across Office for Mac 2011, gives you easy access to all of the media 
you need in your presentations from one centralized, searchable pane. The Media Browser combines 
objects formerly available from the object palette of the Toolbox with access to your media folders and 
libraries. Just drag to insert images, audio, or movies as well as a wide selection of Clip Art, shapes, and 
the full library of symbol characters. 

Figure 3: Easi ly f ind and 
insert photos, audio, 
movies, and more from 
the new and improved 
Media Browser in 
PowerPoint 2011. 

1

§ Access your iPhoto libraries and iTunes playlists directly from the Photos and Audio tabs. You can 

also access iTunes movies and iMovie projects that you save to the Movies folder right from the 
Movies tab. 

§ Search for photos, audio, movies, and shapes by keyword. 

§ Simply drag the zoom slider in the browser to customize your view for larger previews or to 

preview more objects at one time. 
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2

§ Explore a broad range of Clip Art, including more than 100 images with alpha channels that enable 

the graphic to fit seamlessly into your presentation as shown here. 

Quick Tips:  

§ Click the play button beside the search box on the Photo, Audio, and Movie panes to preview 
selected objects.  

§ Right-click objects in the Media Browser for additional options, such as to open an image in 
iPhoto or to copy a shape, Clip Art image or symbol. 
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Embed and format movies 
N

ew
! 

Embed movies and customize your movie experience right in PowerPoint 2011. When you insert 
movies from your files, they are now embedded by default so you don’t have to manage additional 
files when sharing with others. 

You can also easily format the movies you embed from your files: 

§ Movie poster frame. Use your slide area to tell your story more effectively and avoid solid black 
rectangles that are difficult to print. Select a frame from the movie or a picture from your files as an 
image that fills the object area when the movie is not playing.  

§ Movie tools. Add movie effects and styles. The formatting and effects that you apply are retained 
while the movie plays. 

Figure 4: Set playback options, apply a poster frame, or add formatt ing and effects to your movies 
from the Format Movie tab.   
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Quick Tips:  

§ When you embed movie and audio files in your presentations, you embed a copy of that file. So 
all formatting that you do to the media object on your slide affects only the copy of that object 
that resides in your presentation — the original media file is not changed. 

§ Need to insert a movie or audio from your files as a link instead of embedding the file? On the 
Home tab, in the Insert group, click Media and then click Movie from File or Audio from File. 
Then, in the Choose a Movie or Choose Audio dialog box, select the Link to File option before 
inserting your media. When you insert movies or audio as links, you can still use formatting tools 
to customize the media on your slide without affecting the original file. 

§ PowerPoint 2010 for Windows now supports Quick Time and several other media formats, so 
sharing your multimedia presentations with Windows users is easier than ever. Additionally, 
when someone sends you a PowerPoint 2010 presentation that contains a movie edited in 
PowerPoint 2010 – their customizations are retained when you play them back in PowerPoint 
for Mac 2011. 

§ If you receive a presentation that contains Windows Media file objects (WMV for movies and 
WMA for audio) you can play them back on your Mac using Flip4Mac, a free download from 
Microsoft available here: http://www.microsoft.com/mac/products/flip4mac.mspx. Flip4Mac 
enables you to playback Windows Media objects on your slides from within PowerPoint for Mac 
and Windows Media files directly from within Quick Time. 

http://www.microsoft.com/mac/products/flip4mac.mspx
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Movie and audio controls 
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Pause, rewind, fast-forward, and change audio volume while presenting. These new and improved 
controls enable you to manage playback for the movie and audio on your slides without leaving slide 
show mode. 

Figure 5: Just 
point to a 
movie or 
audio object 
during your s l ide show to see and 
access controls .  

Quick Tip: Improved movie and audio controls also appear beneath a selected movie or audio 
object on the slide, so you have more flexibility for playback while editing your slides and planning 

your presentation. 
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Picture editing tools 
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PowerPoint 2011 gives you the freedom to be your own graphic artist with a range of new and 
improved tools for working with images.  

§ Grab only what you want from your image and leave the rest behind with the new Remove 
Background tool. 

§ Perfect your pictures quickly with an advanced cropping tool that enables you to view your full 

image in shadow while you crop. Pan and zoom in on key image elements just by dragging and 
resizing the picture within the crop area. Mask to a shape, crop to a specific aspect ratio, or fit the 
image to the crop area with just a couple of clicks. 

§ Explore new Sharpen and Soften correction tools along with improved Brightness and Contrast. 

§ Experiment with new color tools including Color Saturation and Color Tone, as well as an improved 

Recolor tool. 

§ Apply improved, customizable artistic filters, such as paint strokes, glass, pencil sketch, and pastels. 

Figure 6: The Format Picture tab appears automatical ly whenever a picture is selected. 
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Note:  The same new and improved picture editing tools are also available in Microsoft Word for Mac 
2011 (Word 2011) and Microsoft Excel® for Mac 2011 (Excel 2011). 

Figure 7: Original 
image shown at 
top and then 
clockwise using 
the glow edges, 
cutout, and glass 
art ist ic effects ,  
and with image 
background 
elements removed. Color and correct ion tools help 
turn the same image into the s l ide background. 
Addit ional ly ,  picture sty les and effects are appl ied 
here to add border, shadow, bevel ,  rotat ion, soft 
edges and shapes. 

Quick Tip: The new Remove Background tool works intuitively, automatically adding or removing 
image elements when you drag your mouse pointer over part of the picture. When this feature is 

enabled, just drag your mouse pointer straight across the portion of the picture you want to add or 
remove from the image. 
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Compress pictures 
N

ew
! 

Reduce file size for easier sharing with the new compress pictures functionality. This feature, also 
available in Word 2011 and Excel 2011, enables you to compress a selected image or all images in the 
file and provides a range of picture quality options for compression. 

Figure 8: To access picture compression options, on the Fi le menu cl ick Reduce Fi le Size. 
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Slide transitions 
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Slide transitions can help your presentations look more polished and professional, flow more smoothly, 
and emphasize key talking points. With PowerPoint 2011, you can captivate your audiences with new 
and improved slide transitions, including high-quality 3-D transitions that rival the type of graphic 
effects that you see on TV. 

Figure 9: The Gal lery s l ide transit ion shown here is one of many new 3-D effects avai lable for your 
presentat ions. 
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Choose from an array of new and improved transition effects using the new Transitions tab with a 
more intuitive transitions gallery. You can also access transition options right on the same tab, including 
effect options and playback settings as shown in Figure 10. 

Quick Tips:  

§ Use the transition effect options to multiply the scope of available transitions. Notice, for 
example, the four different types of Cube transitions shown in Figure 10. 

§ Changing the duration of a transition can also provide a very different effect. For example, if you 
like the Vortex transition but it seems more dramatic than you want when it runs (for 4 seconds 
by default), shorten the duration for a lighter, quicker version of the same effect. Access the 
Duration setting on the Transitions tab, in the Transition to this Slide group. 

Figure 10: The new Transit ions tab in PowerPoint 2011. Select a transit ion from the gal lery and then 
select from a range of effect options that vary by transit ion. 
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Animations 
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Animating slide content adds a dynamic element to static slides and helps focus your audience’s 
attention exactly where you want it to be. PowerPoint 2011 adds more advanced motion paths, more 
realistic motion for your favorite animations, and streamlined tools to help you access, customize, and 
apply animations more easily. 

Figure 11: Access, preview and apply animation effects more easi ly in PowerPoint 2011. 

Quick Tips:  

§ The animations available in galleries for entrance, emphasis, and exit effects change 
automatically based on the type of object selected. For example, when you select a movie 
object, emphasis animations include the option to play, pause, or stop the movie. 

§ Animation options become available when you select an animation effect and vary based on the 
selected effect. For example, the options that you see in the callout of Figure 11 are for the 
Wheel entrance effect. 

§ When you switch to the Animations tab while editing slides, objects to which you have applied 
animation show an icon in their top-left corner. Click that icon to select the animation for editing. 
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Additional Office themes 
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You want all of your presentations to have a consistent, professional look — but who has the time for 
all that formatting? You do — just click to apply the theme you want and PowerPoint 2011 does the 
rest. 

The slide master, layouts, backgrounds, fonts, colors, and graphics formatting effects update instantly 
when you format your presentation using themes, helping to ensure that all elements in your 
presentation complement one another. And, when you create Office Art graphics in your presentation 
(such as SmartArt diagrams and Excel 2011 charts), the formatting automatically coordinates with your 
theme.  

Themes were introduced to Office for Mac in Office 2008 for PowerPoint and Word, as well as for Excel 
graphics, enabling you to apply a consistent, professional look to all of your content. Office for Mac 
2011 adds even more professionally designed, built-in themes and provides a pane in the new 

PowerPoint Presentation Gallery where you can customize colors and fonts for those themes (and 
preview your customizations) before you even create your presentation.  

Customize or create your own themes for an effortless way to implement your own personal or 
business branding, or use the designs provided to quickly add impact to any content. The same 
themes are available in Word 2011 and Excel 2011, making it easy for you to brand all of your Office 
2011 documents. 

Figure 12: 
Access al l  
themes in the 
PowerPoint 
Presentat ion 
Gal lery or from 
the Themes tab 
of the r ibbon, as 
shown here. 
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Quick Tips:  

§ Access more than 50 built-in themes from the Themes gallery on the Themes tab in PowerPoint 
2011 and get easy access from that gallery to many more themes available on Microsoft.com. 

§ You can quickly create a custom theme by mixing and matching theme elements. For example, 
select separate theme colors and theme fonts from their respective menus on the Themes tab of 
the ribbon. The selected theme options automatically update in your active presentation. You 
can then use the Save Theme option on that tab to save your customizations as a new theme. 
Once saved, your theme is automatically available to PowerPoint, Word, and Excel. Note that 
themes in Word and Excel apply fonts, colors and graphic effects. Slide master, layout, and 
background theme formatting is exclusive to PowerPoint. 

§ Themes are compatible with Office 2010 and Office 2007 for Windows. So, you can share 
themes with users of Office for Windows and use their themes as well. In fact, you can apply the 
theme from any PowerPoint, Word, or Excel document to any other.6 To do this, on the Themes 
tab, point to the Themes gallery for an arrow you click to expand the gallery. At the bottom of 
the gallery, click Browse Themes to select the document, presentation, workbook, or theme file 
containing the theme you want to apply to the active presentation. 

§ See the Insider Tips and Tricks section later in this guide for information on how to create your 
own completely custom theme. 

6 Applies to documents created using the file formats introduced in Office 2008 for Mac and Office 2007 for Windows, such as pptx for a 
PowerPoint presentation. 
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Additional SmartArt graphics 
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You know that a graphic can often help display your important points more effectively than just text. 
That’s why it’s so important to choose the right type of graphic for your content and make it look its 
best. Fortunately, Office for Mac 2011 adds dozens of additional SmartArt layouts for a total of more 
than 130 different diagrams that you can create as easily as typing a bulleted list. 

These popular graphics, introduced to Mac Office in Office 2008, make it possible for anyone to create 
truly impressive diagrams. SmartArt layouts include a broad range of options from lists to process, 
cycle, and relationship diagrams that can help you convey related ideas and non-linear concepts with 
greater visual impact.  

The new layouts added in Office for Mac 2011 include additional organization charts, picture diagrams, 
and many more. You also get improved tools for working with picture diagrams, such as the ability to 
easily add or replace images from within the text pane or replace selected images in your diagram 

using the Change Picture Command on the Format Picture tab. 

Figure 13: The 
SmartArt tab provides 
gal ler ies of SmartArt 
layouts and formatt ing 
tools to help you 
quickly bui ld the 
perfect diagram. Point 
to any category in the 
insert SmartArt Graphic 
group (or Change 
SmartArt Graphic when a 
diagram is selected) for a 
gal lery of layout options, 
as shown in the cal lout 
here. 
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Note:  SmartArt graphics are also available in Word 2011 and Excel 2011. 

Quick Tips:  

§ In addition to the SmartArt tab that provides SmartArt styles, color, and layout options, the 
Format tab becomes available when a SmartArt graphic is selected. Access drawing object 
formatting tools on this tab that enable you to easily customize individual shapes and text within 
the graphic. 

§ When you insert a SmartArt graphic, a text pane automatically appears. Type in that text pane to 
populate shapes in your graphic with text, press RETURN to add new shapes, and use the TAB 
and SHIFT+TAB keys just as you do in a bulleted list, to promote or demote shapes or text 
within shapes. 

§ When you select a SmartArt graphic in your presentation, the Insert SmartArt Graphic group 
becomes the Change SmartArt Graphic group, as you see in Figure 13. Just select a different 
layout and your graphic automatically updates to take on the new diagram layout while 
retaining your content. 

§ PowerPoint 2011 enables you to convert a boring bulleted list to a SmartArt graphic in just a 
couple of clicks. Click into the bulleted list and then, on the SmartArt tab, in the Insert SmartArt 
graphic group, select the layout you want from the galleries of diagram types. That’s all there is 
to it! 

§ Need to easily extract content from your SmartArt graphic? On the SmartArt tab, in the Reset 
group, use the new Convert options to convert the graphic to shapes or text. 
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Tables and table styles 
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Format tables to more easily coordinate with your presentation, and layout and manage tables more 
easily using the Tables tab in PowerPoint 2011. 

§ Explore table styles that coordinate with your active document theme, along with additional 
formatting options such as banded rows and columns.  

§ When your insertion point is in a table, get the contextual Table Layout tab where you can easily 

structure and manage your table from one central location, as shown in the image that follows. 

Figure 14: The Table Layout tab appears automatical ly when your insert ion point is in a table. 

Quick Tip: When you view table styles available on the Tables tab, the previews in the Table Styles 
gallery change as you select table options such as header row, total row, or row and column banding 

— so you can see the effect of your selected options on a table style before you even apply it. 
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Charts 
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Select from more intuitive galleries of charts on the new Charts tab, along with new Chart Quick 
Layouts providing a wide range of options for your selected chart type with just one click. When you 
select a chart, the Chart Layout and Format tabs also become available to give you centralized, 
simplified access to all of the chart editing tools you need.  

Excel charts were introduced as a native PowerPoint feature in Office 2008, and are improved in 
PowerPoint 2011 with easier access to a wider range of charting tools. 

Figure 15: Create, format, and edit charts easi ly with quick access to al l  of the tools you need on 
the Charts ,  Chart Layout, and Format tabs. 

Note:  Excel charts are also natively available in Word 2011. 

Quick Tips:  

§ When a chart is selected, the Insert Chart group on the Charts tab automatically becomes the 
Change Chart Type group. Just click a different chart type to change the active chart. 

§ Save your customized chart as a chart template. To do this, on the Charts tab, in the Change 
Chart Type group, click Other and then, at the bottom of the gallery, click Save as Template. 
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Presenter View 
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Keep your focus on the content and on your audience, and make it look effortless, with the improved 
Presenter View.  See what your audience sees along with all the tools you need to keep you easily in 
control of your presentation. 

§ Multiple panels show you what the audience currently sees, a thumbnail of what the audience will 
see next, and the slide notes. You also get a panel where you can add meeting notes as you 
present, without leaving presenter view. 

§ Use the same tools that you have in standard slide show view, such as a pointer for on-slide 

annotations and the ability to hide or jump to the slide you need. 

§ Separate displays show you the current time of day clearly and the time elapsed in your slide show, 

to help you easily keep the pace of your presentation. 

§ Point to the bottom of the screen for a filmstrip view of all slides in your presentation, and just click 
a thumbnail to jump to that slide for your audience. 

Figure 16: Presenter v iew automatical ly puts al l  of the presentat ion tools you need r ight in front of 
you. 
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Quick Tips:  

§ On the Slide Show tab, in the Presenter Tools group, click Presenter View to rehearse and plan 
your presentation using Presenter View tools without having to be connected to a second 
display. 

§ Presenter View easily adjusts to your presentation style. For example, just point to the bottom of 
the screen to display a filmstrip of your slides, as shown in Figure 16. Click a slide in the filmstrip 
to instantly display that slide to your audience. As also shown in that figure, you can drag the 
slider that appears to the left of the notes panes to change the font size in which note text 
appears on screen.  

§ Recording your slide show narrations and timings is also made easier in PowerPoint 2011 using 
these new presenter tools. On the Slide Show tab, in the Presenter Tools group, click Record 
Slide Show. Your screen automatically changes to Presenter View, where you can record slide 
timings and narration together. 
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Dynamic reordering 
N
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Think outside the box with an instant 3-D vision of all layers on your active slide. This stunning new 
feature, also available in Word 2011, lets you view and easily rearrange ordering for all of the objects 
on the slide by simply dragging. 

§ Numbers appear on layers as you scroll through them to clearly indicate the current order. 

§ Drag to change the order of objects and then just press Enter or click OK to set. Or, press Escape 
to cancel your change and close the dynamic reordering view. 

Figure 17: Get 
an instant 3-D 
view of al l  
layers on your 
act ive s l ide, 
master,  or 
layout with 
Dynamic 
Reordering. This example shows a 
s l ide with mult iple layers for an 
animated bui ld. 
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Quick Tips:  

§ Dynamic reordering is an easy way to access objects that are layered or hidden behind other 
slide content or just to view content positions. For example: 

• When complex animation builds don’t play as expected, adjusting the layering of objects on 
your slide may be a quick and easy way to correct results. One quick, 3-D view at all layers 
on the slide — such as in Figure 17, — gives you the complete visual story and lets you 
make necessary adjustments instantly.  

• Or, when you want to customize elements of a template or theme, instantly see how the 
design is constructed while editing the master or layouts so that you can easily access the 
pieces you need and make it your own. 

§ Dynamic reordering in PowerPoint shows you the objects on the slide when working in Normal 
view or on the active layout or master when working in a master view. For example, the 
following image shows the title slide layout of the built-in Sky theme. 
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Presentation Sections 
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Presentations can contain dozens of slides, but organizing and managing them no longer has to be a 
challenge. In PowerPoint 2011, you can assign slides into logical groupings or sections for easier 
navigation and organization. Name sections to assign a set of slides to a team member or otherwise 
customize the organization of your slide sections. In addition, you can save time by moving to slides by 
section while in your slide show or by printing your slides by section. 

Figure 18: Organize and manage sl ides more easi ly using new presentat ion sect ions. 

Quick Tips:  

§ View sections in the Slides pane in Normal view or in Slide Sorter view, as shown in Figure 18.  

§ Get options for working with sections on the Home tab, in the Slides group, or by right-clicking a 
section heading. 

§ Click the arrow beside a section name to collapse or expand the slides in that section.  
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Find tools 
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Find what you need quickly with the new Search in Presentation box, available on the Standard toolbar.  

Type your search term and then just press Return (or use the next and previous buttons) to cycle 
through all results in your presentation. The Find feature in PowerPoint searches for your terms in text 
on slides, masters, and layouts as well as in notes, shapes, SmartArt graphics and even text in chart titles 
and labels. 

Figure 19: Get to the results 
you need more quickly and 
easi ly with the new Search in 
Presentat ion tool .  

Quick Tip: The familiar Command+F shortcut now places your insertion point in the Search in 
Presentation box automatically. To access Replace tools or more Find options, click the magnifying 

glass icon in the search box and then click either Advanced Find to open the classic Find dialog box 
or click Replace. 
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Streamlined performance 
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Work more quickly and easily with enhanced performance for many of your favorite, familiar features in 
PowerPoint 2011.  

See improvements from the moment you launch the application — from changing your view to 
applying themes and formatting, large presentations won’t slow you down.  

Figure 20: 
Experience 
seamless 
performance 
throughout 
PowerPoint 2011, 
such as when you open a large presentat ion in 
Sl ide Sorter v iew and see s l ide thumbnai ls 
update immediately.  
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Visual Basic for Applications (VBA) 
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Microsoft Visual Basic® for Applications (VBA) returns to Office 2011 to give advanced users more tools 
for automating repetitive tasks or extending PowerPoint functionality. 

§ Write simple macros to save yourself time on repetitive or cumbersome tasks. 

§ Use the immediate window to get information from your presentation or apply settings with 

precision when creating themes and templates. 

§ Create add-ins with custom functionality to share with others. 

Figure 21: Write 
macros in VBA to 
save t ime on 
cumbersome 
tasks, as shown 
in the example 
here, or to 
customize your 
PowerPoint 
experience. 

Quick Tips:  

§ If you’re an advanced user of any version of Microsoft Office, you might be amazed at how 
familiar VBA language will seem and how easy it is to learn to use, just because you know 
program features such as working with slides or shapes. Explore the new VBA developer center 
at http://iheartmacros.com to help get started. The resources there focus on Office for Windows 
but most of them apply equally to Office for Mac. Also, check out the Insider Tips & Tricks in this 
guide for tips on what you can do with VBA and how to get started. 

§ When you want to save macros to a presentation file, be sure to use the macro-enabled file 
formats. The default presentation file format, pptx, cannot store macros (as denoted by the x at 
the end of the file extension). Instead, select the pptm file format. When you expand the Format 
list in the Save As dialog box, you see four Office 2011 formats in which you can save macros: 
pptm (macro-enabled presentation), potm (macro-enabled template), ppsm (macro-enabled 
show), and ppam (PowerPoint add-in).  

http://iheartmacros.com
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Help 
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Get started right away with video tutorials, take self-paced, easy-to-follow online tutorials, and access a 
wide range of help resources from one centralized online location. Office 2011 gives you more choices 
for fast answers that make it easy to get started or to take your work in PowerPoint to a new level. 

§ The welcome screen when you first start PowerPoint 2011 gives you one-click access to online 
video tutorials on a range of topics. Don’t want to watch a video right then? On the Help menu, 
just click Welcome to PowerPoint at any time. 

§ Also on the Help menu, click Get Started with PowerPoint to open an online site where you’ll see 

an array of resources. 

§ Or, click PowerPoint Help for the familiar PowerPoint help dialog box and the option to go online 
to explore the full range of help videos, self-paced tutorials and more. 

Figure 22: Easi ly access 
an array of help 
resources from one 
central onl ine locat ion. 

Quick Tip: Did you know that you can get answers to your Office for Mac questions from your 
peers, experts who volunteer their time, and folks on the Mac Office product team? Check out the 

Office for Mac forums and search to see if someone else has already asked your question or post a 
question yourself. You can also check out the Office for Mac blog, where the product team 

frequently posts tips, tricks, and information about new and interesting features. Access both the 
forums and the blog from http://microsoft.com/mac. 

http://microsoft.com/mac
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Zoom 
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Use the new zoom slider on the status bar at the bottom of the screen, as well as the one-click fit slide 
shortcut, to quickly and easily get to exactly what you need to see. 

Figure 23: Access the 
new zoom sl ider and 
f i t  s l ide shortcuts on 
the Status bar, at the bottom-
right corner of the screen. 
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Design and presentation advice 
N
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§ Looking for guidance on how to create engaging presentations? PowerPoint 2011 provides 

templates from presentation experts to help you get started, with tips ranging from design advice 
to how to capture and keep your audience’s attention.  

§ Get creative advice from Academy Award®-winning Duarte Design in the Five Rules template. 

§ Get tips and examples from four different successful presenters with unique perspectives on how to 

create engaging presentation that help you make an impact. For example, see the template It’s All 
Too Much by professional organizer and author Peter Walsh. 

To access these guided presentations, in the PowerPoint Presentation Gallery, under Templates, click 
Guided Methods. 



Work more easily with others 
When you need to work with other people, you 
shouldn’t have to worry about whether they work 
on Mac or Windows, or how you’re going to 
share and manage your project. Fortunately, 
Office for Mac 2011 takes care of those details for 
you with seamless cross-platform collaboration 
tools that help you get the exact results you want 
every time. 
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Broadcast Slide Show 

Faster than arranging a Web meeting, easier than getting everyone in the same room — now you can 
broadcast your slide show live to a remote audience with just a few clicks.7 Everyone you invite to your 
presentation can view the show in high fidelity and in real-time from their web browser, whether or not 
they have PowerPoint installed. 

Broadcast Slide Show creates a URL that you can share with others by email or instant message. When 
someone clicks the link, they can watch your slide show broadcast in most browsers on both Mac and 
Windows.8 

N
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Figure 24: When 
you begin your 
s l ide show using 
the new Broadcast 
Sl ide Show feature, v iewers watch 
the presentat ion in real-t ime, from 
their web browser. 

7 Requires a free Windows Live ID. 

8 The broadcast slide show feature uses PowerPoint Web App to display the broadcast for viewers. For Office Web App requirements, including 
supported browsers, see the Requirements\Disclaimers section at the end of this guide. 

Quick Tip: PowerPoint 2011 uses Windows Live as the default broadcasting service. Broadcasting 
via Windows Live is a free service that enables up to 50 attendees per broadcast. 

 
When you use Windows Live as your broadcasting service, a copy of your presentation is stored on 

Microsoft server while you are presenting, and becomes inaccessible after the presentation ends. 
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Co-authoring 

Save time, simplify tasks, and improve your teamwork. Co-authoring capabilities in PowerPoint 2011 
take compatibility to a whole new level. Edit the same presentation at the same time as other people in 
different locations who are using PowerPoint 2011 or PowerPoint 2010 for Windows.9 Automatically 
see who else is editing and on which slide they’re working. You can even initiate a conversation with 
other editors on both platforms instantly, right from PowerPoint 2011.10 
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Figure 25: Clearly 
see where another 
editor is  working in 
the same 
presentat ion, 
quickly access their 
contact 
information, and 
connect with them 
without leaving 
PowerPoint.  

1

§ Just save the presentation to see changes from other editors as you work. Your changes also 

become available to other editors each time you save. 

§ See the number of people currently editing the file on the Status bar at the bottom of the screen, 

as shown in Figure 25. Click that icon for a pop-up list that displays the names of all current 
editors at-a-glance.  

9 Co-authoring requires SharePoint Foundation 2010 for enterprise use or, for personal and small business use, a free Windows Live ID to save 
and access files via SkyDrive. 

10 Viewing presence information and initiating an IM, voice, or video conversation from within PowerPoint 2011 requires either Microsoft 
Messenger for Mac 8 or Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac 2011. Your computer must 
have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator 
for Mac. 
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§ If another editor goes offline while they have the file open for editing, you can still access the 

presentation and make your changes. When that person is next online and saves the file, the 
changes they made are merged with yours and you can then see their changes. 

Quick Tip: If you're in a small company or use PowerPoint 2011 for your home or school work, you 
can take advantage of co-authoring capabilities through SkyDrive. All you need is a free Windows 
Live ID to save and access your presentations via SkyDrive so that you can edit them simultaneously 
with others. With Microsoft Messenger for Mac 8, you can also view availability of other presentation 
authors and start an instant messaging, voice, or video conversation directly from PowerPoint. 

Corporate users in companies running SharePoint Foundation 2010 can use co-authoring within 
their firewall. If your company also uses Microsoft Communicator for Mac 2011, you can view 
presence information and initiate instant messaging, voice, or video conversations directly from 
PowerPoint.11  

11 Viewing presence information and initiating an IM or voice call from within PowerPoint 2011 using Microsoft Communicator for Mac 2011 
requires Microsoft Office Communication Server 2007 R2. 
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Rich presence and on-the-spot communication 

Connect with your contacts without leaving PowerPoint 2011.  

As shown in Figure 25, you see a presence icon for other current editors while in a co-authoring 
session in PowerPoint 2011.  

When you use either Microsoft Communicator for Mac 2011 or Microsoft Messenger for Mac 8, you 
can view information about that person and initiate an instant message (IM), voice, or video 
conversation via their contact card, as shown in Figure 26.12 
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Figure 26: Hover on a person’s 
presence icon where you see it  in 
PowerPoint to view their contact 
card and instantly in it iate a 
conversat ion. 

 

12 Viewing presence information and initiating an IM, voice, or video conversation from within PowerPoint 2011 requires either Microsoft 
Messenger for Mac 8 or Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac 2011. Your computer must 
have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator 
for Mac. 

Quick Tips:  

§ Microsoft Exchange users see calendar free\busy information as well as out of office messages 
on the top portion of the contact card. 

§ For more information about available communication options, see the Messenger for Mac 8 and 
Communicator 2011 Product Guide. 

Note: Presence information and contact card are also available when using co-authoring in Word 
2011 and presence is visible when using the Send by IM command in Word 2011. In Microsoft Outlook 
for Mac 2011 (Outlook 2011), these features are available from many types of Outlook items, such as 
meeting requests and email messages. 
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Information Rights Management (IRM) 

Information Rights Management, now available across Office for Mac 2011, enables Mac and Windows 
users to share sensitive documents more easily. Help protect your PowerPoint 2011 presentations from 
unauthorized access and distribution, and enforce those restrictions even if that file leaves your 
company’s secure network.13 

§ Set permissions for individual users or groups. 

§ Identify who can read the file as well as whether they can print, edit, or copy its contents.  
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Figure 27: Use IRM to help protect 
sensit ive presentat ion content with the 
abi l i ty to provide permiss ions to 
specif ic users and customize 
permiss ions. 

13 Creating IRM-protected presentations with Office for Mac 2011 requires the volume license edition of Office 2011, as well as a Rights 
Management server running Windows Server 2008 R2 SP1. Opening IRM-protected content to which you have been given access can be done 
from any edition of Office for Mac 2011 or from Office for Windows 2003 or later. 

Note: For Outlook 2011 email messages, IRM protection can also prevent users from forwarding the 
message to others. 
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Compare and Merge 

PowerPoint 2011 saves you time and helps simplify group projects with Compare and Merge tools 
available from the Review tab, as shown in Figure 28. Compare multiple versions of the same 
presentation and then review edits to accept or reject changes.  

A Compare Changes pane enables you to review details of changes by slide along with a thumbnail of 
the compared slide and the option to accept or reject changes. 
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Figure 28: Review changes to your presentat ion from the Review tab in the Compare group. 

Quick Tip: When you compare two versions of a presentation, changes are considered rejected by 
default. So, as on the Review tab shown in Figure 28, you see the available Accept option. If you 

accept a change, the Reject option becomes available. 



 

 

Work how, when, and where you 
choose 
It’s easy to create great content when you can 
work when and where you choose, and work 
seamlessly with others regardless of the tools 
they use. 
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PowerPoint Web App 

When you want to leave your computer behind or need familiar, shareable tools for collaborating with 
others, do you have what you need to get things done easily and effectively? Now you do. 

Save your PowerPoint presentations online and then access, edit, and share them from virtually any 
computer with an Internet connection.14 Get high-fidelity online viewing for the rich presentations that 
you create in PowerPoint 2011, run your slide show, and easily make light edits on the go.15 
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Figure 29: Get things done 
when and where you choose 
with the new PowerPoint Web 
App. 

14 Office Web Apps require an appropriate device, Internet connection, supported Safari, Firefox, or Internet Explorer browser, and either 
SharePoint Foundation 2010 for enterprise or, for personal and small business use, a free Windows Live ID to save and access files via SkyDrive. 
There are some differences between the features of Office Web Apps and the Office 2011 applications. 

15 Microsoft Silverlight™ is not required for any functionality but is recommended for best results when viewing PowerPoint presentations in Office 
Web Apps. 
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Quick Tips:  

§ PowerPoint Web App makes it easy to share files with people who work on earlier versions of 
Microsoft Office for Mac or Windows, or even with those who don’t have Microsoft Office 
installed on their computer. 

§ Use PowerPoint Web App to access and view documents that you save to a SharePoint 2010 
site or a SkyDrive folder directly from your mobile device. Office Web Apps provide mobile 
access to the PowerPoint presentations and Word documents that you save to SharePoint 2010 
or SkyDrive, as well as to the Excel workbooks that you save to a SharePoint 2010 site.16 

§ In addition to the Office Web Apps that you can access for viewing, editing and sharing your 
files online via SkyDrive or SharePoint 2010, Microsoft Exchange users can access their Outlook 
2011 email, calendar, and contacts online using Microsoft Outlook Web App. 

§ View your slides, slide notes, or run your slide show from PowerPoint Web App.  

§ Use familiar features that you know from PowerPoint, including the ability to add, duplicate, delete 

and hide slides, apply font and paragraph formatting, and more. 

§ Insert or replace pictures and even apply picture styles.  

§ Insert, edit, and format SmartArt graphics, including changing SmartArt styles and layouts. 

16 Word, Excel, and PowerPoint files can be viewed using Office Web Apps on many devices.  Supported mobile viewers for Office Web Apps on 
SharePoint 2010 include Safari 4 on iPhone 3G and 3GS, Internet Explorer on Windows Mobile 5/6/6.1/6.5, BlackBerry 4.x and later, Nokia S60, 
NetFront 3.4, 3.5 and later, Opera Mobile 8.65 and later, Openwave 6.2, 7.0 and later. Supported mobile viewers for Office Web Apps on 
SkyDrive include Safari 4 on iPhone 3G, 3GS, and iPad, and Internet Explorer 7 on the upcoming Windows Phone 7.  Viewing Excel files via a 
mobile browser is currently only available with Office Web Apps on SharePoint 2010. 
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Save to SkyDrive 

Free yourself from your desk, get free online storage for accessibility and backup, and make it easier to 
work where you want, when you want and with whom you want. 

All it takes is a free Windows Live ID to get 25GB of free online storage for your documents and 
photos. And when you store your presentations on SkyDrive, you can access and edit them with Office 
Web Apps or edit them simultaneously with others who use PowerPoint for Mac 2011 or PowerPoint 
2010 for Windows. 

Now, you can save your PowerPoint presentations to SkyDrive directly from PowerPoint 2011. To do 
this, on the File menu point to Share and then click Save to SkyDrive to login with your Windows Live 
ID. Need a Windows Live ID? Just click Get a Live ID in the sign-in dialog box shown in Figure 30. Or, 
check out docs.live.com and click Sign Up. 
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Figure 30: Use your free 
Windows Live ID to save your 
presentat ions to SkyDrive 
r ight from PowerPoint 2011. 

Note: This feature is also available in Word 2011 and Excel 2011. 

http://docs.live.com
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Save to SharePoint 

If you work in an organization that runs SharePoint 2007 or later, you can now save your PowerPoint 
presentations to your SharePoint sites directly from PowerPoint 2011.  

Saving presentations to SharePoint gives you easy access to your files from wherever you need to be. 
With SharePoint 2010, you can also simultaneously edit those presentations with others on your team. 
And if your organization runs Office Web Apps on SharePoint 2010, you can access and edit 
presentations that you save to SharePoint from virtually anywhere.  

Saving your presentations to a SharePoint site helps you work more easily in several ways, such as the 
following: 

§ Keep files accessible to all team members, regardless of their location. 

§ Access and restore previous versions, and create and manage document workflows. 

§ Create team sites and libraries to manage content and projects more effectively. 
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Figure 31: Save your presentat ion 
to a SharePoint s i te for enhanced 
document management tools and 
easy access from virtual ly 
anywhere. 

Note: This feature is also available in Word 2011 and Excel 2011. 
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Insider Tips & Tricks 

Are you the office, family, or class PowerPoint genius? Do you support, teach, or create presentations, 
templates, or themes for other PowerPoint users? If you are a PowerPoint power user or just want to 
explore how to take PowerPoint even further, check out the insider tips and tricks that follow. 

Create a custom Office theme 
When you apply a theme to your PowerPoint presentation, you get a coordinated set of fonts, colors, 
and graphic formatting effects, as well as a slide master, a set of slide layouts, and a gallery of slide 
background options. You also have that same theme available in Word 2011 and Excel 2011, where 
you can apply the fonts, colors, and graphic effects from the theme to your documents and 
workbooks. And, themes are compatible with Office 2010 for Windows, so you can seamlessly share 
your design as well as your content across platforms. 

If you want to customize a theme, you can apply a different set of theme fonts or theme colors with 
just a click, or customize the slide master and layouts. And you can save those customizations as your 
own theme, so that it is also available to any Office 2011 presentation, document or workbook you 
create.  

But, how can you create a completely custom theme with all of your own settings, such as to 
implement your company or personal branding? It might be much easier than you think. 

The following tips tell you what features or tools you can use to help customize each theme element. 
Then, read on for additional tips and direction on how to get started. 

Notice that several of the following tasks can be completed in PowerPoint (such as editing the slide 

master and layouts) and others use Office Open XML. Keep in mind that you can customize quite a lot 
about the theme from within PowerPoint — such as creating theme colors and customizing the slide 
master and layouts. The options to explore Office Open XML are added here for those who would like 
to explore ways to take themes even further.  
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§ Create theme colors. 

On the Themes tab, in the Theme Options group, click Colors and then click Create Theme Colors. When 
you select colors for your theme, notice that different colors have different purposes in the theme. For 
example, the six accent colors are used when you create charts or SmartArt graphics. 

§ Create theme fonts. 

You can copy an existing theme font file and easily edit it using the Text Edit application on your Mac. See 
the Office Open XML tips that follow for more information. 

§ Customize the slide master and slide layouts. 

You can use many of the same features discussed in this product guide for editing slides, such as new and 
improved picture editing tools or the new dynamic reordering tool to simplify customizing masters and 
layouts. You may also be able to use some basic VBA to save time and get flawless results. For more 
information, see the tips that follow on getting started with VBA. 

§ Create custom graphic formatting effects and slide background gallery options. 

§ Set default shape and line formatting. 

Every theme contains an XML file that stores the theme font and color settings as well as the settings for 
graphic effects and background gallery styles. You can edit this file in the Text Edit application on your 
Mac to customize all of its settings, and learning how to get that done might be much easier than you 
think. See the Office Open XML tips that follow for more information. 

Sometimes very small customizations can make very big differences in how easy your theme is to use. In a 
theme (or a presentation or template), you can set default shape and line formatting. When you do, this 
information is saved with the theme, presentation, or template so that when someone inserts a shape or 
line, it takes on the formatting you have set by default. To do this, format a shape or line as desired and 
then right-click for the options Set as Default Shape or Set as Default Line. 
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Customize presentations and save time using Office Open XML 

With all of the great new features in PowerPoint 2011 and Office for Mac 2011, you never have to 

leave the Office 2011 programs to create the brilliant presentations you’ve always wanted. But, if you 
are an advanced user and you want to see just how far you can take the great content you create with 
Office 2011, you might want to check out what’s going on under the hood of your presentations. 

The Office Open XML Formats are the file formats for your Office 2011 PowerPoint, Word, and Excel 
documents, and were first introduced to Office for Mac in Office 2008. A lot of the great functionality 
that you use in Office 2011 is built using the Office Open XML language — such as Office themes and 
SmartArt. And, if you are an advanced Microsoft Office user, you may be amazed at the time you can 
save and the customizations you can do when you begin to explore Office Open XML. 

You don’t need to be a professional developer to learn and use the basics of Office Open XML. With 
just a few Office Open XML basics under your belt, you can customize formatting and save time on 
many tasks. Consider the following examples — and then check out the list of articles and online 
training that follows to learn how to get it done: 

§ You use the Shape feature on the SmartArt tab to change the rectangles in your SmartArt graphic 
to ovals. It works great and may be exactly what you need most of the time. But when you add a 
new shape, it’s still a rectangle. Would you like to change that shape in the SmartArt layout instead, 
so that anyone who edits the graphic gets the shape you want them to use? 

§ You are about to email your pitch 10 minutes before the deadline when you learn that the client 

changed their logo last week. That logo appears dozens of times in the presentation and the clock 
is ticking. Wouldn’t it be nice if you could just paste the new logo once and PowerPoint would 
place it everywhere it needed to be, with formatting, sizing, and positioning automatically retained? 

When you understand the core Office Open XML structure of your PowerPoint 2011 presentations, you 
can — and you might even be able to do it without writing a single word of Office Open XML. 

All it takes is one simple find and replace in Office Open XML. 
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§ When you need to create a custom theme, as discussed earlier in this section, you know that you 

can create theme colors or customize the slide layout and masters from within PowerPoint. But, to 
create a custom theme font set or to customize theme effects and slide background gallery styles, 
you’ll want to check out Office Open XML. 

Use the steps that follow to create a custom theme font set. And see the theme-related articles in the list 
that follows for instructions on how to customize theme effects and the slide background gallery. 

1. In PowerPoint 2011, on the Home tab, under Theme Options, click Fonts.  

2. Explore the Fonts menu to find the closest built-in font set to the custom font set you need. For 
example, if you want to create theme fonts that use your custom font for headings but Century 

Gothic for the body font, notice that the Apothecary theme already uses the body font you need. 

3. In Finder, browse to: /Applications/Microsoft Office 2011/Office/Media/Office Themes/Theme Fonts. 
Then, copy Apothecary.xml (or whichever theme font set you selected in step 2). 

4. Browse to /Users/[your user name]/Library/Application Support/Microsoft/Office/User Templates/My 
Themes/Theme Fonts and then paste the copied file. 

5. Change the name of the file to the name that you want for your new theme font set. Then, right-click 

the file, point to Open With, and then click Other. Select Text Edit and then click Open. 

6. Depending on which file you open, it may look like one of the two images on the following page. 
Although they look very different, they contain the same required information. 

The file on the left is formatted to show each line individually and contains a number of optional pieces of 
information (font script definitions for use with different languages). The file on the right allows the text to 
run in paragraph format (no line breaks) and contains only the required information plus a definition for 
one font script (Japanese in this case). 

The required information where you need to make changes is shown with a red underscore in both 
images. This includes the name of the theme font set (the same name that you just gave the copied file), 
the name of the heading font you want to use (called the major font in the XML) and the name of the 
body font you want to use (called the minor font in the XML). Notice that the primary font names that you 
need to change for use with English text (as well as any Latin typeface language) appears in the XML tag 
named a:latin typeface. 
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7. Simply change the name of the theme font set at the top of the file, and then change the font name 
for the heading or body font to the font you want to use. Be sure to use the exact font name as you 

see it in the Font lists in Office 2011 programs.   

Note: If you want to edit, add or remove the font script definitions for other individual languages, 
you can. However, when making any edits in this file (or any XML file) take care not to delete or add 
characters that do not belong. For example, if you accidentally delete just one quotation mark or 
angle bracket while making your edits, the file will not work correctly. If you choose to delete font 
scripts for languages you don’t need, be sure to delete the entire associated tag, with its surrounding 
angle brackets, and nothing else. 

8. Save and close the file. When you next open PowerPoint 2011 (or Word or Excel 2011), you see your 
new font set at the top of the Theme Fonts gallery. 
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These are just a few of many tasks that advanced Office for Mac 2011 users can easily accomplish 
using basic Office Open XML. Explore the resources that follow to help you get started with Office 
Open XML and for the steps you need to accomplish these tasks and more: 

Note: The following resources were written for Office 2007 for Windows, but are also applicable to the 
tasks discussed here for Office for Mac 2011. 

§ Office Open XML I: Exploring the Open XML File Formats  

§ Office Open XML II: Editing documents in the XML  

§ Using Office Open XML to Customize Document Formatting in the 2007 Office System  

§ Getting More from Document Themes in the 2007 Office System with Office Open XML (if you're 

new to themes and Office Open XML, read this article before the one that follows)  

§ Creating document themes with the Office Open XML Formats 

§ Using Office Open XML to Save Time Without Writing Code 

 

http://office.microsoft.com/training/training.aspx?AssetID=RC102435331033
http://office.microsoft.com/training/training.aspx?AssetID=RC103570001033
http://msdn.microsoft.com/en-us/library/dd560821.aspx
http://msdn.microsoft.com/en-us/library/dd630117.aspx
http://msdn.microsoft.com/en-us/library/cc964302.aspx
http://msdn.microsoft.com/en-us/library/dd627338.aspx
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Save time and get flawless results using basic VBA 

You’re not a programmer and have no desire to be one. So why should you explore VBA? VBA is not 

just a programming language. It’s also a very powerful feature of the Office for Mac programs you use 
every day, and it’s designed to be used by advanced Office for Mac users like yourself. 

VBA enables you to automate and extend the familiar features of your favorite Office for Mac 
programs, for more flexibility to help you create incredible, customized content. In fact, just because 
you already know how to use PowerPoint features — you already know much more VBA than you 
think. And you do not have to be a programmer to get a lot from VBA with very little effort. Consider 
the following examples: 

§ A change in your branding means that every rectangle on every slide in your 100 slide pitch book 
presentation needs be a rounded rectangle. It’s easy enough to do, but boring and time-
consuming for sure. Instead, write a simple VBA statement called a loop to automatically loop 
through all slides, find the rectangles, and change them to rounded rectangles. 

Instead of an hour or two, accomplish the same thing in a minute or two — and get better results 
because you know that no shapes will be accidentally overlooked. 

§ You’re customizing slide layouts for a new theme. You position a content placeholder on one 

layout and then check the Format Shape dialog box to get its position. But, when you apply that 
position to a placeholder on the next layout, the placements of the two objects aren’t quite 
identical. When you need positioning to be more precise than dialog boxes allow, don’t waste time 
and energy on trial and error. 

It takes just one line of VBA to get the exact position of the first object and just one more to apply that 
position precisely to any other objects that need to match. Use the Immediate Window in the Visual Basic 
editor anytime you need to get information from your presentation or execute a single action that you 
can’t do from within the PowerPoint presentation window. 
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These are just a couple of the many tasks that you can simplify using basic VBA. Explore the resources 
that follow to help you get started with VBA and for the steps you need to accomplish these tasks and 
more: 

Note: The following resources were written for Office 2007 for Windows but are also applicable to the 
tasks discussed here for Office for Mac 2011.  

§ Chapter 21: (introduction to) VBA Primer (partial chapter excerpt from Advanced Microsoft Office 
Documents 2007 Edition Inside Out, for core VBA basics) 

§ Extending Word 2007, Excel 2007, and PowerPoint 2007 with a Single Line of VBA Code (on using 

the Immediate Window) 

§ Using VBA to Format Long Documents in the 2007 Office System in a Fraction of the Time (on 

using loops and conditional statements to cycle through your content) 

And don’t forget to check out the VBA Developer Center on MSDN at http://iheartmacros.com. This 

site focuses on Office for Windows, but many of the resources you’ll find there are also applicable to 
using VBA in Office for Mac 2011.  

http://iheartmacros.com
http://msdn.microsoft.com/en-us/library/dd721892.aspx
http://msdn.microsoft.com/en-us/library/dd535470.aspx
http://msdn.microsoft.com/en-us/library/dd554917.aspx
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Where to Find It  

Create Incredible Content  

 Features and Benefits Where to Find 
Improved! Ribbon § The ribbon appears below the menu bar and toolbar at 

the top of the screen.  

§ To minimize the ribbon, click the active tab name or press 
Command+Alt+R. To expand a minimized ribbon, click 
any tab.  

§ To configure how the ribbon displays, on the PowerPoint 
menu click Preferences (or press Command+,) and then 
click Ribbon. 

New! PowerPoint Presentation 
Gallery 

§ On the File menu click New from Template. You can also 

click the New from Template icon  on the Standard 

toolbar or press Command+Shift+P. 

New and 
Improved! 

Media Browser § On the Standard toolbar, click the Media Browser icon. Or, 
on the View menu click Media Browser. 

New! Embed movies from your 
files 

§ To insert a movie from your files, on the Home tab of the 
Ribbon, in the Insert group, click Media and then click 
Movie from File.  

§ To insert a movie from your Movie folder using the Media 

Browser, on the Standard toolbar, click the Media Browser 
icon shown here and then click Movies.  

§ Or, on the Home tab, in the Insert group, click Media and 
then click Movie Browser.  

Note: Movies that you drag onto a slide from a Finder 
window are also embedded automatically. 

New! Format movies § Select a movie in your presentation. The Format Movie tab 
appears automatically whenever a movie is selected.  

§ Access Poster Frame, Movie Styles, Movie Effects, and 
more on the Movie Tools Format tab. 
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 Features and Benefits Where to Find 
New and 
Improved! 

Movie and audio controls § Point to a movie or audio object in your presentation to 
view and access controls.  

Note: Controls appear below the object in Normal view and 
on the object in Slide Show view. 

Improved! Picture editing § Select as picture in your presentation.  

Note: To insert a picture, open the Media Browser to the 
Photos or ClipArt panes. Or, on the Home tab, in the Insert 

group, click Picture to insert a picture from your files or from 
ClipArt.  

§ The Format Picture tab appears automatically when a 
picture is selected. Artistic Effects, Remove Background, 

Color, Correction, and Crop tools are located in the Adjust 
group. 

New! Compress pictures § On the File menu click Reduce File Size or on the Format 
Picture tab, in the Adjust group, click Compress to access 
picture compression options. 

Improved! Slide transitions § On the Transitions tab, in the Transition to This Slide 

group, point to any transition in the gallery to preview or 
click a transition to apply it to selected slides. 

Improved! Animations § Select an object to animate. Then, on the Animations tab, 
select an option from the Entrance Effects, Emphasis 

Effects, Exit Effects, or Motion Path galleries. Select options 
for your chosen effects in the Animation Options group. 

Improved! Themes § On the Themes tab, in the Themes group, see all built-in 
Office themes as well as the option to save your own 
custom themes or set your selected theme as the default.  

§ Or, to create a new presentation based on a theme, open 

the PowerPoint Presentation Gallery. To do this, on the File 
menu click New from Template or, on the Standard 
toolbar, click the New from Template icon. 
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 Features and Benefits Where to Find 
Improved! SmartArt graphics § Click the SmartArt tab for the Insert SmartArt Graphic 

group where you can browse through galleries of several 
diagram types and just click to insert the graphic of your 
choice.  

§ The SmartArt and Format tabs appear automatically 
whenever your insertion point is in a SmartArt graphic. 

Improved! Tables and table styles § The Tables tab of the ribbon includes options for inserting 
and formatting tables. The Table Layout tab appears 

automatically whenever your insertion point is in a table 
and provides tools for editing and managing the table 
structure.  

§ Improved table styles, including additional options such as 
banded rows and columns, are available on the Tables 
tab, in the Table Options group. 

Improved! Charts § The Charts tab of the ribbon includes options for inserting 
and formatting charts. The Chart Layout and Format tabs 
appear automatically whenever your insertion point is in a 
chart.  

§ Access options for changing chart type, layout, and style 
on the Charts tab.  

§ Get one-stop access for editing many chart elements on 
the Chart Layout tab.  

§ Format chart elements just like you do shapes on the 
Format tab. 

Improved! Presenter View § Presenter View is on by default when you open a 

presentation in Slide Show view while your computer is 
attached to two displays.  

§ To open Presenter View at any time, on the Slide Show 
tab, in the Presenter Tools group, click Presenter View. 
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 Features and Benefits Where to Find 
New! Dynamic reordering § On the Home tab, in the Format group (or on the Format 

tab, in the Arrange group), click Reorder and then click 
Reorder Objects.  

§ When in 3-D reorder mode, drag layers forward and back 

to rearrange them. Press Escape to cancel your changes 
or Return to accept your changes and return to your 
document. 

New! Presentation Sections § On the Home tab, in the Slides group, click Section. 

Improved! Find tools § On the Standard toolbar, click in the Search in 
Presentation box (or press Command+F) to type a search 

term. You can then use the next and previous buttons that 
appear in the search box to scroll through search hits in 

the presentation. Or, just press Return to move to the next 
search hit.  

Note: To access additional find options or replace options, 
click the magnifier icon in the search box and then click 
Advanced Find or Replace to open the dialog box that you 

know from previous versions. You can also access this dialog 
box with the familiar keyboard shortcut Command+Shift+H. 

Improved! Streamlined performance § Performance improvements are automatic as you use 
several features. For example, apply a new theme to your 

presentation and see the changes update throughout 
your slides without any wait. Or, change the layout of a 
SmartArt graphic containing pictures to see the new 
layout applied instantly and your pictures retained. 

Improved! VBA § On the Tools menu, point to Macro and then click Visual 
Basic Editor. Or press Alt+F11. 

Improved! Help § On the Help menu, select Welcome to PowerPoint for 
quick access to several video tutorials. Or, click Get Started 

with PowerPoint to visit the Office for Mac help site for 
Office 2011, with a range of resources including tutorials, 
videos, and help topics.  

Improved! Zoom § On the Status bar at the bottom of the screen, you see the 

new zoom slider along with an icon for one-click access to 
the Fit Slide zoom setting. 
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 Features and Benefits Where to Find 
New! Design and presentation 

advice 

§ In the PowerPoint Presentation Gallery, under the 
Templates heading, click Guided Methods.  

Work more easily with others 

 Features and Benefits Where to Find 
New! Broadcast Slide Show § On the Slide Show tab, in the Start Slide Show group, click 

Broadcast Slide Show. 

New! Co-authoring § To see this feature, save your presentation to a SharePoint 
2010 site or a SkyDrive folder, and then have someone 

else open the file for editing in either PowerPoint for Mac 
2011 or PowerPoint 2011 for Windows while you are still 
in it.  

§ You can automatically see where other editors are 
currently working in the presentation. You can also view a 

list of other editors on the Status bar at the bottom of your 
screen.  

Note: Your changes become available to other authors 
when you save the file. You also see changes made by other 
authors when you save. 

New! Rich presence and on-the-
spot communication 

§ While in a co-authoring session, you see the presence 
status of other authors who are editing the presentation 
with you, such as green for available.  

§ Click an editor’s name or presence icon for a contact card 
from which you can initiate a conversation.  

Note: Viewing presence information and initiating an IM, 

voice or video conversation from within PowerPoint 2011 
requires either Microsoft Messenger for Mac 8 or Microsoft 
Office Communications Server 2007 R2 with Microsoft 

Communicator for Mac 2011. Your computer must have an 
installed microphone for voice calls and an installed video 

camera to use the video capabilities in Messenger for Mac 
or Communicator for Mac. 
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 Features and Benefits Where to Find 
New! Information Rights 

Management (IRM) 

§ On the Review tab, in the Protection group, click 
Permissions and then click Manage Credentials. Or, on the 
File menu, point to Restrict Permissions and then click 
Manage Credentials.  

Note: This feature is available in the volume license edition 
of Office for Mac 2011. 

New! Compare and Merge § On the Review tab, in the Compare group, click Compare. 

Work how, when, and where you choose 

 Features and Benefits Where to Find 
New! Access your presentations 

on the web 

§ Visit http://office.microsoft.com/web-apps for information 
on how to get started with Office Web Apps 

New! Save to SkyDrive § On the File menu, point to Share, and then click Save to 
SkyDrive.  

Note: Use of SkyDrive requires a free Windows Live ID and 
provides 25GB of online file storage. Sign-up for your 
Windows Live ID at docs.live.com. 

New! Save to SharePoint § On the File menu, point to Share, and then click Save to 
SharePoint.  

Note: Requires SharePoint 2007 or later. 

 

http://office.microsoft.com/web-apps
http://docs.live.com
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Version Comparison 

☐ Feature\Benefit Included  n Improved þ New 

Create incredible content 

Get easier access to the right tools, at the right time 

 2008 2011 

Ribbon  þ 

Get to the commands you need more easily with 
the new ribbon designed expressly for Office for 
Mac 2011.  

  

PowerPoint Presentation Gallery  þ 

Access built-in and online themes and templates, 
as well as your own custom themes and 

templates, and recently accessed presentations. 
Customize built-in content and preview your 
results before you even create the presentation. 

  

Media Browser  þn 

Get consolidated access to all of the media you 
need in your presentations, from pictures and 
movies to shapes and symbols. 

Note: In PowerPoint 2008, some elements of this 
feature were included on the Formatting Palette. 
The Media Browser pane is new to PowerPoint 

2011. 
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Make the media fit the message 

 2008 2011 

Embed movies from your files  þ 

Movies that you insert from your files are 
embedded by default in PowerPoint 2011, helping 
to ensure that your presentation is always ready to 
travel. 

  

Format movies  þ 

Format movies that are inserted from your files 
right from within PowerPoint. Set a preview image 
and add styles and effects that are retained while 
the movie plays. 

  

Movie and audio controls n n 

Instantly move to any location in the movie or 
audio object inserted from your files as you 
present and control the audio level while a movie 
plays. 

  

Picture editing n þn 

Advanced color, correction, and cropping tools, a 
new background removal tool and professional-
quality artistic effects, enable you to edit pictures 
like a pro. 

  

Compress pictures  þ 

Compress the pictures in your presentations to 
reduce file size and make presentations easier to 
share. 
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Create extraordinary presentations 

 2008 2011 

Slide transitions n n 

Captivate audiences with exciting special effects, 
such as high-quality 3-D effects, that look just like 
graphics you’d see on TV. 

  

Animations ☐ n 

Access and customize animations more easily, 
explore additional animations such as advanced 
motion paths, and bring presentations to life by 
adding realistic motion to stationary objects.  

  

Additional Office themes þ n 

Select from a wide range of additional Office 
themes to apply fonts, colors, and formatting 
effects — as well as slide master, layout and 
background formatting — throughout your 
presentation with just a click. 

  

Additional SmartArt graphics þ n 

Select from several new SmartArt layouts — 
including new organization charts and picture 
diagrams — to build professional graphics as 
easily as typing a bulleted list. 

  

Tables and table styles n n 

Explore additional options for table styles, such as 
banding of rows and columns, and consolidated 
access to all the table tools you need on the 
Tables and Table Layout tabs of the ribbon. 

  



Page 67 

 2008 2011 

Charts n n 

Get additional tools for formatting and editing 
charts, including Chart Quick Layouts and 
expanded quick access options for editing many 
chart elements. 

  

Save time and simplify your work 

 2008 2011 

Presenter View ☐ n 

Keep the focus on your message with improved 
presentation tools that make it simple to stay in 
control of all aspects of your presentation. 

  

Dynamic reordering  þ 

View document layers in 3-D and drag to 
rearrange them. 

  

Presentation Sections  þ 

Easily organize and navigate through your slides 
by dividing your presentation into logical sections. 

  

Find tools ☐ n 

Use the new Search in Presentation box to quickly 
scroll through search results in your presentation. 
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 2008 2011 

VBA  n 

Use VBA, available again across several Office 
2011 applications, to save time, automate 
repetitive tasks, and create add-ins for yourself 
and others to use. 

  

Help ☐ n 

Explore a range of videos to help you get started 
with PowerPoint 2011 as well as expanded help 
resources including tutorials, videos, and help 

topics. 

  

Zoom ☐ n 

Use the new zoom slider on the Status bar at the 
bottom of the screen and just drag to zoom in or 
out on the active slide content.  

  

Design and presentation advice  þ 

Explore the Guided Methods templates, available 
from the PowerPoint Presentation Gallery, for 
expert design and presentation advice. 

  

Work more easily with others 

 2008 2011 

Broadcast Slide Show  þ 

Instantly broadcast your slides to a remote 
audience who can view your presentation online 

even if they don’t have PowerPoint installed on 
their computer. 
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 2008 2011 

Co-authoring  þ 

Work with other people editing the same 
presentation, at the same time. 

  

Rich presence and on-the-spot 
communication 

 þ 

Instantly initiate a conversation with others who 
are simultaneously editing a document with you, 
right from PowerPoint. 

  

Information Rights Management (IRM)  þ 

Control access to your sensitive documents using 
enterprise-level document protection tools. 

  

Compare and Merge  þ 

Quickly compare multiple presentation versions 
and combine edits into a single presentation file. 

  

Work how, when, and where you choose 

 2008 2011 

PowerPoint Web App  þ 

View and do lightweight editing of PowerPoint 
presentations from virtually any computer with a 
web browser. Run your slide show, edit slide 
notes, and use some of the same formatting and 
editing tools that you know from PowerPoint. 
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 2008 2011 

Save to SkyDrive  þ 

Save your personal documents to a SkyDrive 
folder directly from PowerPoint, using your free 
Windows Live ID. 

  

Save to SharePoint  þ 

Save your documents to a SharePoint 2010 site 
directly from within PowerPoint 2011. 
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FAQ 

About Microsoft PowerPoint 2011 
1. What is PowerPoint 2011? 
2. How can I use PowerPoint 2011? 
3. What are some of the major updates to PowerPoint 2011 from earlier versions? 

PowerPoint 2011 System Requirements & Compatibility 
1. Are there special system requirements for running PowerPoint 2011? 
2. Can I open previous versions of PowerPoint presentations in PowerPoint 2011? 
3. Can I open PowerPoint 2011 presentations using previous versions of PowerPoint? 
4. Do I need other products in order to use PowerPoint 2011 features? 
5. Which browsers are supported for the new PowerPoint Web App? 

Using PowerPoint 2011 
1. Are there free PowerPoint 2011 resources and training available from Microsoft? 
2. Can I customize PowerPoint 2011 based on how I use the product? 
3. Can I access my presentations when I am away from my primary computer? 
4. How do I access PowerPoint 2011 presentations from a web browser? 
5. What can I do with my PowerPoint 2011 presentations in PowerPoint Web App? 
6. How do I access PowerPoint 2011 presentations from my phone? 

Buying PowerPoint 2011 
1. Which editions of Office for Mac 2011 will include PowerPoint 2011? 
2. Will PowerPoint 2011 be available for standalone purchase? 
3. Can I try PowerPoint 2011 before I buy it? 
4. Is there a cost for using PowerPoint Web App? 

PowerPoint 2011 Feature-Specific Questions 
1. What is co-authoring in PowerPoint 2011 and what are the benefits of using it? 
2. Which Office for Mac 2011 applications enable co-authoring? 

3. What are the requirements for using co-authoring in PowerPoint 2011? 
4. How does the new co-authoring capability in PowerPoint 2011 avoid editing conflicts? 
5. How do people see and hear my presentation when I use the new Broadcast Slide Show feature? 
6. What audio and movie formats are supported in PowerPoint 2011? 
7. What happens to my original movie file when I insert a movie from my files? 
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About Microsoft PowerPoint 2011 

1. What is PowerPoint 2011? 

PowerPoint 2011 is the most intuitive and compatible release yet of the powerful presentation software 
you already know. Designed to provide you with the flexible, dynamic presentation tools you need, 
PowerPoint 2011 makes it easy to create presentations that impress. Customize and manage media like 
a pro, incorporate astounding slide show effects, and easily share your presentations with others. In 
addition, this release of PowerPoint makes it simpler to work with others across platforms and across 
continents, or to get things done when and where you choose. 

2. How can I use PowerPoint 2011? 

Use PowerPoint 2011 to create presentations that help you express your important ideas effectively. 
Whether you need a few slides to share with friends or colleagues or you’re preparing the pitch of your 
career, take advantage of easy-to-use tools ranging from professional-quality picture editing to 
Hollywood-quality transitions and animations, a wide range of customizable design themes that you 
can apply with a click, and beautiful graphics that you can create as easily as typing a bulleted list. You 
can also use PowerPoint 2011 to share your presentations easily with others — such as by broadcasting 
your slide show instantly to a remote audience or seamlessly editing a presentation at the same time as 
others on your team — whether they work on a Mac or on Windows. 

3. What are some of the major updates to PowerPoint 2011 from earlier versions? 

Explore PowerPoint 2011: At-a-Glance. 
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PowerPoint 2011 System Requirements & Compatibility 

1. Are there special system requirements for running PowerPoint 2011? 

Following are the recommended minimum system requirements for installing and running Office 
for Mac 2011: 

Computer: § A Mac computer with an Intel processor.  

Operating System: § Mac OS X version 10.5.8 or later.  

Memory: § 1 GB or higher recommended. 

Hard Disk: § 2.5 GB of available hard disk space. 

§ HFS+ hard disk format (also known as Mac OS Extended or HFS Plus) 

Web Browser: § Safari 5 or later recommended. 

Installation: § DVD drive or connection to a local area network (if installing over a network). 

Display: § 1280 x 800 or higher resolution monitor. 

Additional requirements 
(may vary based on your 
edition of Office 2011): 

§ Certain online functionality requires a Windows Live ID.  

§ Certain features require Internet access (fees may apply). 

§ Co-authoring and Broadcast Slide Show require Microsoft SharePoint 

Foundation 2010 (for enterprise) or a Windows Live ID (for personal or small 
business use). 

§ Exchange support in Outlook for Mac 2011 requires connectivity to Update 
Rollup 4 for Exchange Server 2007 Service Pack 1 or later. 

§ Access to files stored on a SharePoint site requires connectivity to SharePoint 
2007 or later. 

§ Communicator 2011 requires an account on Microsoft Office 
Communications Server 2007 R2. 

§ The Photos, Audio, and Movies tabs of the Media Browser require 
(respectively) iPhoto 5 or later, iTunes 6 or later, and iMovie 3 or later. 

2. Can I open previous versions of PowerPoint presentations in PowerPoint 2011? 

Yes. You can open presentations created in PowerPoint v. X or later in PowerPoint 2011. 

3. Can I open PowerPoint 2011 presentations using previous versions of PowerPoint? 

Yes, by using free Open XML file format converter for Mac, you can open presentations in 
PowerPoint v. X or later that are saved to the PowerPoint 2011 default file formats. You also have 
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the option in PowerPoint 2011 to save your presentations to the file formats used by PowerPoint 
97 through PowerPoint 2004.17  

4. Do I need other products in order to use PowerPoint 2011 features? 

None of the content creation or formatting tools in PowerPoint 2011 requires other products. 
However, the following tools do have additional requirements: 

§ Media browser: The Photos, Audio, and Movie panes in the Media Browser integrate 
automatically with your iPhoto, iTunes, and iMovie libraries, respectively. 

§ Co-authoring: Requires SharePoint Foundation 2010 for enterprise or, for personal and small 

business use, a free Windows Live ID to save and access files via SkyDrive. 

§ Broadcast Slide Show: Requires a free Windows Live ID.  

§ See availability of other editors currently working in your presentation and 

communicate with them instantly from within PowerPoint 2011: Requires either Microsoft 
Messenger for Mac 8 or Microsoft Office Communications Server 2007 R2 with Microsoft 
Communicator for Mac 2011. 

 
17 Saving a PowerPoint 2011 document to the PowerPoint 97 – 2004 format or editing a PowerPoint 2011 presentation in an earlier version of 
PowerPoint will limit some functionality in the file. Additionally, certain presentation elements (such as SmartArt graphics) are automatically 
converted to pictures to preserve their appearance in some earlier versions of PowerPoint. 
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5. Which browsers are supported for the new PowerPoint Web App? 

Supported browsers include Safari 4 or later for Mac, Firefox 3.5 or later for Mac, Windows, or 
Linux, and Windows Internet Explorer 7 or later for Windows. 

Using PowerPoint 2011 

1. Are there free PowerPoint 2011 resources and training available from Microsoft? 

When you first open PowerPoint 2011, you see the Welcome Screen, which provides a link to 
several video tutorials to help you get started. To access the welcome screen at any time, on the 
Help menu click Welcome to PowerPoint. Also on the Help menu, click Get Started with PowerPoint 
to go to a help site online that contains a range of videos, tutorials, and help topics. 

You can also access these self-help resources at anytime from http://microsoft.com/mac, where 
you can also ask questions of your peers and independent experts – such as the Microsoft Most 
Valuable Professionals — in the Office for Mac forums. 

2. Can I customize PowerPoint 2011 based on how I use the product? 

You can customize many aspects of PowerPoint 2011, including the following: 

§ Configure the way the ribbon displays. On the File menu, click Preferences and then click 
Ribbon.  

§ Customize menus and toolbars. On the View menu, point to Toolbars, and then click 

Customize Toolbars and Menus. 

§ Set your preferences for a wide range of presentation and program behavior, ranging 

from how proofing and AutoCorrect features behave, to slide show behavior, how presentation 
content displays and prints, and how to help protect your presentations. Access all of these settings 
and many more in the Preferences dialog box. To do this, click the File menu and then click 
Preferences. 

§ Customize and create your own themes, templates and reusable content. You can 
customize formatting and layout for your presentations and presentation content when you work 

in PowerPoint 2011. From customizing and creating your own themes, to customizing built-in 
templates or creating your own, it’s easy to make your presentations your own. Get help for these 
features through the Help button on the right edge of the ribbon in PowerPoint 2011, or on 
microsoft.com. 

http://microsoft.com/mac
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3. Can I access my presentations when I am away from my primary computer? 

Using the new PowerPoint Web App, you can save your presentations online and then access, 
view, search, edit, and share them from virtually any computer with an Internet connection. Office 
Web Apps also enables you to access and view your presentations from your mobile device.18 

4. How do I access PowerPoint 2011 presentations from a web browser? 

Save your presentations to a SharePoint 2010 site or a Windows Live SkyDrive folder and then view 
and edit them using PowerPoint Web App. 

5. What can I do with my PowerPoint 2011 presentations in PowerPoint Web App? 

Share your presentations with others who can edit the presentation online regardless of which 
version of PowerPoint they have installed on their computers, whether they work on Mac or 
Windows, or even if they don’t have PowerPoint installed.  

In PowerPoint Web App, you can view your PowerPoint 2011 presentations with high fidelity, view 
or copy note content, or run your slide show directly from PowerPoint Web App view mode. In 
PowerPoint Web App edit mode, use some of the same formatting and editing features you use 
every day in PowerPoint 2011, including editing and formatting text on your slides and in the notes 
pane; creating, duplicating, deleting or hiding slides; inserting and editing SmartArt graphics; and 
inserting or replacing pictures. 

6. How do I access PowerPoint 2011 presentations from my phone? 

Save your documents to a SharePoint 2010 site or a SkyDrive folder and then access and view 
them from your mobile device, using PowerPoint Web App.19 

Buying PowerPoint 2011 

1. Which editions of Office for Mac 2011 will include PowerPoint 2011? 

PowerPoint 2011 is available for purchase as part of all Office 2011 suites. To view a suite 
comparison for Microsoft Office for Mac 2011 so you can determine which suite is right for you, 
visit http://microsoft.com/mac. 

 
18 Web and mobile access via Office Web Apps require an appropriate device, Internet connection, supported browser and either SharePoint 
Foundation 2010 or a Windows Live ID. There are some differences between the features of the Office Web Apps and the Office 2011 
applications. For a list of supported browsers for computers and mobile devices, see the Requirements/Disclosures section of this document. 

19 PowerPoint files can be viewed via Office Web Apps on many mobile devices. For a list of supported mobile viewers, see the 
Requirements/Disclosures section of this document. 

http://microsoft.com/mac
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2. Will PowerPoint 2011 be available for standalone purchase? 

Yes. 

3. Can I try PowerPoint 2011 before I buy it? 

Yes. A trial version of Office 2011 will be available. Visit http://microsoft.com/mac for more 
information. 

4. Is there a cost for using PowerPoint Web App? 

Office Web Apps are available in two ways: 

§ Businesses that have a volume license agreement for Office for Mac 2011 have access to install 
Office Web Apps on SharePoint 2010 in their organization.  

§ Individuals can access Office Web Apps via SkyDrive, at docs.live.com, using a free Windows Live 

ID. 

PowerPoint 2011 Feature-Specific Questions 

1. What is co-authoring in PowerPoint 2011 and what are the benefits of using it? 

Co-authoring is an exciting new development in PowerPoint 2011 that enables you to 
simultaneously edit the same document with others who are working in different locations, using 
PowerPoint for Mac 2011 or PowerPoint 2010 for Windows. You no longer have to wait for one 
person to finish writing or editing their portion of the document before you can work on it.  

2. Which Office for Mac 2011 applications enable co-authoring? 

Office for Mac 2011 enables co-authoring in PowerPoint 2011 and PowerPoint 2010. Co-authoring 
is also enabled in OneNote Web App and Excel Web App.  

3. What are the requirements for using co-authoring in PowerPoint 2011? 

Co-authoring requires SharePoint Foundation 2010 for enterprise or, for consumers and small 
business, a free Windows Live ID to save and access files via SkyDrive. 

4. How does the new co-authoring capability in PowerPoint 2011 avoid editing conflicts? 

The merge capabilities of PowerPoint 2011 co-authoring are designed to minimize editing conflicts. 
However, if a conflict does occur, you see a merge view in which PowerPoint 2011 identifies the 

conflict and enables you to choose how you prefer to resolve it. You also have the option to save 
and review a file when co-authoring, in order to review the changes made by all authors. 

http://microsoft.com/mac
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5. How do people see and hear my presentation when I use the new Broadcast Slide 
Show feature? 

When you broadcast your slide show, you send a link to the location from which people can view 
the slide show online. Broadcast slide show is intended for when you need to deliver your 
presentation live to people in other locations. So, viewers hear the presentation as you deliver it 
over a telephone or other audio medium that you provide. 

6. Can Windows Media formats (WMV video and WMA audio) play in PowerPoint 2011? 

Yes. You can play WMV and WMA files in the PowerPoint presentations you receive by installing 

Flip4Mac (http://www.microsoft.com/mac/products/flip4mac.mspx). This download provides 
components that enable you to playback the Windows Media objects in presentations you receive 
as well as to playback Windows Media files in Quick Time on your Mac. 

7. What happens to my original movie file when I insert a movie from my files? 

Your original movie file is unaffected when you insert a movie from your files into PowerPoint 2011. 
PowerPoint embeds a copy of your movie file by default and you also have the option to link the 
movie object to the original file instead of embedding it. Whether you link or embed your movie, 
you can format the movie object on your slide without affecting the original. 

http://www.microsoft.com/mac/products/flip4mac.mspx
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Requirements/Disclosures 

Office Web Apps 
Office Web Apps are online companions to Microsoft Office and require the following:   

§ For enterprise businesses and institutions: Requires SharePoint Foundation 2010. 

§ For personal and small business use: Requires a free Windows Live ID. 

§ For use on computers: Supported browsers include Safari 4 or later for Mac, Firefox 3.5 or later 

for Mac, Windows, or Linux, and Windows Internet Explorer 7 or later for Windows 

§ For use on mobile devices: Word, Excel, and PowerPoint files can be viewed using Office Web 

Apps on many devices.  Supported mobile viewers for Office Web Apps on SharePoint 2010 
include Safari 4 on iPhone 3G and 3GS, Internet Explorer on Windows Mobile 5/6/6.1/6.5, 
BlackBerry 4.x and later, Nokia S60, NetFront 3.4, 3.5 and later, Opera Mobile 8.65 and later, 
Openwave 6.2, 7.0 and later. Supported mobile viewers for Office Web Apps on SkyDrive include 
Safari 4 on iPhone 3G, 3GS, and iPad, and Internet Explorer 7 on the upcoming Windows Phone 7.  

Viewing Excel files via a mobile browser is currently only available with Office Web Apps on 
SharePoint 2010. 

Co-authoring 
Co-authoring for PowerPoint 2011 is the capability to simultaneously edit the same PowerPoint 2011 
presentation with other people in different locations. This functionality requires the following: 

§ For enterprise businesses and institutions: Requires SharePoint Foundation 2010. 

§ For personal or small business use: Requires a free Windows Live ID to save and access files 

via SkyDrive. 

Rich Presence and On-the-Spot Communication 
Rich presence and integrated communication tools in Office for Mac 2011 enable you to view the 
availability of other document editors and communicate with your contacts without leaving PowerPoint 
2011. These capabilities have the following requirements: 
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§ Viewing presence information and initiating an IM, voice, or video conversation from within 
PowerPoint 2011 requires either Messenger for Mac 8 or Office Communications Server 2007 R2 
with Communicator for Mac 2011. 

§ Your computer must have an installed microphone for voice calls and an installed video camera to 

use the video capabilities in Messenger for Mac or Communicator for Mac. 

Broadcast Slide Show 
Broadcast Slide Show enables you to broadcast your PowerPoint 2011 presentation live to a remote 

audience who can view your presentation online even if they don’t have PowerPoint installed on their 
computer. This feature requires a free Windows Live ID.  

§ Broadcasting via Windows Live is a free service that enables up to 50 attendees per broadcast. 

This document is provided “as-is.” Information and views expressed in this document, including URL 
and other Internet web site references, may change without notice. You bear the risk of using it.  

Some examples depicted herein are provided for illustration only and are fictitious.  No real association 
or connection is intended or should be inferred.  

This document does not provide you with any legal rights to any intellectual property in any Microsoft 
product. You may copy and use this document for your internal, reference purposes. 

© 2010 Microsoft Corp. All rights reserved. 

Microsoft, Windows, Excel, Internet Explorer, Outlook, PowerPoint, Segoe, SharePoint, SkyDrive, 
SmartArt, Visual Basic, and Windows Live are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries.   

iMovie, iPhoto, iTunes and Safari are trademarks of Apple Inc., registered in the U.S. and other 
countries. 

All other trademarks are property of their respective owners. 
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